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We need to thank our FIRST sponsor -



You should have already downloaded and installed Fusion 360. 
If you haven’t please see the email previously sent with details.

Open the software. You may be prompted to sign into Autodesk.

Click on New Project and name it RoboEagles.



Your screen should look similar to the one shown below.



Assemblies, Bodies, & Components

In Fusion 360, a Body is any continuous 3D shape. Whenever 
you create a 2D sketch in Fusion 360 and then extrude it into a 
3D shape, you automatically create a Body.

So therefore, the Bracket we made is considered a Body.

There are four types of Bodies; Solid, Surface, Mesh, and 
TSpline (Polygon).

Bodies are shown as a solid cylinder in the project tree.



Assemblies, Bodies, & Components

A Component is a part that is capable of motion and has its 
own unique origin.

Components are “containers” that can contain Bodies, and 
Bodies can be converted into Components. They can also 
contain Construction Planes, Sketches, Canvases, Origin Planes, 
and other Components.

Components are shown as a solid cube in the project tree.



Assemblies, Bodies, & Components

An Assembly can contain one or more Components.

Bottom-Up Assemblies are when each piece of the assembly is 
a separate file and imported into the assembly. Top-Down 
Assemblies are where each piece is a component within the 
assembly. This is important because of the relationships 
between each piece. Top-Down creates links that automatically 
adjust based on the changes made.

Assemblies are shown as a three stacked component cubes in 
the project tree.

Components can be combined within a main assembly to create 
Subassemblies. This helps to organize your project and makes it 
easier to work within it.



Assemblies, Bodies, & Components

The Unofficial Rules –

#1 Always start your design with a new component.

This ensures that you always start out with the right file  
structure.

#2 Always rename assets right after creation.

This enables you to easily navigate through your assembly 
and its components.

We didn’t follow these rules…



We Converted a Body Into a Component

1 - Select Body1 in the Project Browser.

2 - The bracket will become highlighted.

3 - Right-Click and select Create 
Components from Bodies.



We Created a New Component

6 – Under Create choose New Component.

7 – Rename the component to “Link”. Note that the component named “Link” 
appears in the Project Browser but it is empty and only has Origin information.



We Created a Construction Plane

10 – Create a Sketch on the Construction Plane.

11 – We need to Project the hole to enable us to create that relationship with the 
Link Component. To do this select Project from the Create Menu.



We Talked About Parametric Relationships

12 – Select the hole and click OK. It will now be highlighted on the sketch plane. 
This will create a Parametric Relationship between the two Components. So for 
example, if the bolt size changes and we modify the Bracket hole size the Link’s 
hole will change as well.

Note: This is a good reason for Top-Down Assemblies.



Parametric Relationship Through Constraints

13 – Draw a circle using the Center Diameter Circle Tool any place on the sketch. 
Set the diameter to be 1.50”.

14 – Now we need to set Constraints to anchor the Circle to the Bracket. To do 
this select the Concentric Tool from the Constraints Menu either by clicking on 
the icon or selecting it from the menu. Choose both circles and click OK. The 
circle should Snap to the Center Point of the Projected Circle.



We Used Symmetric Press Pull Tool

22 – The Sketch has disappeared and will need to be turned back on. To do this 
click on the Eye Icon for Sketch1 under the Link Component and Sketches 
Folder.

23 – Press Pull the Link Arm the same way as Step 21 to a Symmetric Distance of 
.375”.



We Used the Mirror Tool

29 – Use the Press Pull Tool to recess the form .25” in.

30 – Use the Mirror Tool to duplicate the shape on the other side. To do this 
select Mirror from the Create Menu.   



We Used the Combine Tool

32 – Now we need to remove the material where the two components overlap. 
To do this we will use the Combine Tool. Select it under the Modify Menu. The 
Target Body is the Link and the Bracket is the Tool Bodies. Make sure to change 
the Operation to Cut and check the Keep Tools box. Click OK to remove the 
overlap.



We Grounded the Bracket

33 – To begin we need to Ground our Bracket to keep it from moving. To do this 
right click on the Bracket and choose Ground from the menu. You will see a push 
pin appear in the Component cube.



We Added a Pivot Joint With Motion

34 – Next we need to create a Joint. Select the Joint Tool from the Assemble 
Menu. 
35 – The Joint Tool Window will appear an the Bracket will turn transparent. 
Choose the inside edge of the Link.
36 – The Link will turn transparent and Bracket will turn solid. Choose the 
outside edge of the Bracket.
37 – Select the Motion Type as Revolute by clicking on the drop down or using 
the Motion Tab in the Joint Tool Window. The Link will animate and rotate 
around the joint. Click OK.



We Set Pivot Joint Limits For Motion

38 – Click on the Red Down Arrow to edit the Joint Limits. The Edit Joint Limits 
Window will appear.

39 – Click the 3 check boxes to enable the limits and enter -180 deg as a Min, 
0 deg as Max, and 0 deg as the Rest position.

40 – Click Animate to verify limits are set and if good click OK.



Let’s Build a Robot

1 – Click on the Show Data Panel symbol.
2 – Click the New Projects Button and create a new Project called 3568.
3 – Double click on the 3568 project button.



Let’s Build a Robot

4 – Download the KoP Files from
https://www.autodesk.com/education/competitions-and-events/first/recommended-software

5 – Scroll down the page and select the Fusion 360 Kit of Parts and the FTC 
Skystone STEP Kit of Parts. Download and unzip the files (remember where 
the files are located).

https://www.autodesk.com/education/competitions-and-events/first/recommended-software


Let’s Build a Robot

6 – Click on the Upload Button.

7 – Click on Select Files or drag and drop the unzipped files into the Project.

8 – You should see the files listed in the window. Click on the Upload Button 
and the parts will be loaded into your Project.

(you may want to create folders first, see next slide for details.)



Let’s Build a Robot

9 – You should see the parts get loaded into your Project Data Panel. I would
recommend creating New Folders and sorting out the parts. This will make it 
easier to find the parts and to add new ones down the road.

`



Let’s Build a Robot

10 – First let’s look at the Align Function. Start be creating a New Sketch on the XY-
Plane.
11 – Draw a 12” X 12” Rectangle and Press Pull it to a .25” thickness.
12 – Find, grab, and drag the CTRE_PDP_1 v2 part from the Project Data Panel into 
the design. You can position the part and when ready click OK.

(You may get an error if you haven’t saved the design, if so save and add the part after.)

`



Let’s Build a Robot

13 – To locate the PDP on the Backplate, select the Align Tool from the Modify 
Menu. 
14 – Select the bottom surface of the PDP and the front surface of the Backplate. 
The PDP should align itself to the Backplate. Click OK.



Let’s Build a Robot

15 – Select the Move/Copy Tool and drag the PDP into position on the Backplate. 
Change the Move Object to Components and select the Translate Move Type. 
When finished placing the PDP click OK.



Let’s Build a Robot

16 – Switch the view to the Front View and zoom in on the PDP.
17 – Transfer the mounting holes to the back plate by creating a Sketch on the
surface of the Backplate. You will be prompted to capture the change in position 
for the PDP. Click the Capture Position Button.
18 – Using the 2-Point Circle Tool, zoom in on each of the four mounting holes 
and select the top and bottom points of each circle.
19 – Finish the Sketch, turn off the PDP image using the Eye Icon, and extrude 
the holes through the Backplate using the Press Pull Tool. (You can repeat the 
steps for all components you place on the Backplate and print the pattern to 
scale for a template.)



Let’s Build a Robot

20 – Let’s add mounting holes for Tetrix C-Channel to the Backplate. Start by 
adding a Tetrix_39069 to your design. Rotate and translate the C-Channel into a 
position close to the Backplate.

21 – Use the Align Tool to align the back surface of the C-Channel to the 
Backplate, and repeat with the outside edge of the C-Channel and the Backplate.



Let’s Build a Robot

22 – Use the 2-Point Circle Tool to transfer the top and middle holes to the 
Backplate at both ends of the C-Channel. Turn off the C-Channel but do NOT 
Finish Sketch.
23 – Use the Circular Pattern Tool in the Create Menu to make a Pattern of holes 
around the outside of the middle hole. Select the outside edge of the top hole as 
the Object, click on the Select Center Point and pick the outside edge of the 
middle hole, enter either 4 or 8 for a Quantity, and click OK.



Let’s Build a Robot

24 – To verify the hole patterns you can turn the C-Channel back on and zoom in 
to make sure they line up, or you can also check the distance between the center 
points of the top and middle holes. They holes should be 8mm (.315 in) apart 
center-to-center. To do this select the Measure Tool from the Inspect Menu. 
Select the center points of the top and bottom circle and confirm the distance.



Let’s Build a Robot

25 – If the holes measure or look correct, Finish Sketch and use the Press Pull 
Tool to punch the circles through the Backplate. Turn the C-Channel back on.

26 – To build a Chassis import another Tetrix_39069 into the design. Position it in 
the design using the translate arrows and click OK. Make (3) more copies using 
the Move/Copy Tool from the Modify Menu. Select the C-Channel, choose 
Translate Move Type, check the Create Copy Box, drag the copied C-Channel to 
either side of the original, and click OK. Repeat until (4) C-Channels are present.



Let’s Build a Robot

27 – Using the Move/Copy Tool, rotate two C-Channels 90 degrees. To do this
select the C-Channel, choose the Rotate Move Type, select the top center hole 
as the rotate Axis, enter +- 90 for the Angles, check the Capture Position Box, 

and click OK. Repeat the process for both and then rotate the C-Channel along to 
front bottom edge. Arrange as needed to form the four sides of the Chassis.



Let’s Build a Robot

28 – To assemble the Chassis we need to use the Align Tool under the Modify 
Menu and the Joint Tool under the Assemble Menu. Start by aligning the bottom 
surfaces of the front and rear C-Channel to the top surfaces of the left and right 
side rails. Align the outside edges of the C-Channels.

29 – Use the Joint Tool to create a Ridged Joint between the outside middle 
holes at each corner. Ground the right side rail, Capture Positions if prompted, 
select the end middle hole bottom edge on the part you want to move, select 
the middle hole top edge on the grounded rail, the rail will slide into place, and 
click OK. Repeat the process for the other (3) corners.



Let’s Build a Robot

30 – Select the PDP, Backplate, and C-Channel from the previous Assembly, right 
click on the PDP, and select Rigid Group. This will allow us to move all three 
pieces together without losing their relationship to each other.

31 – Attach the Backplate to the Chassis using the Algin Tool and Joint Tool. Align 
the bottom edge of the C-Channel attached to the Backplate to the top surface 
of the upper cross member. Also align the two outside edges of the pieces.



Let’s Build a Robot

33 – Rotate the 3-Piece Assembly around the outside middle hole using the 
Move/Copy Tool.

34 – Using the Joint Tool, create a Rigid Joint by selecting the top edge of the 
middle hole of the second floret in from the edge of the outside rail and the 
bottom edge of the middle hole of the last floret on the C-Channel attached to 
the backplate. Click OK.



Let’s Build a Robot

You can continue to Assemble the pieces until the robot is complete. There are 
even bolts, washers, and nuts if you want to go into that much detail. For now 
we’ll move on to the Canvas Tool.



Using the Text & Canvas Tools

35 – Rotate the design so the outside edge of the Backplate is shown.

36 – Select the Text Tool from the Create Menu and drag a text box from the top
left corner about a third of the way down the Backplate to the other edge.

37 – Select Text, enter 3568, choose a font, enter 3.5” for the height, center the 
horizontal and vertical spacings, click OK if everything looks good, and Finish 
Sketch.



Using the Text & Canvas Tools

38 – Use the Press Pull Tool to Join the text out .50” and click OK.

39 – Use the Canvas Tool in the Insert Menu to insert the FIRST Logo on the 
outside surface of the Backplate.

40 – Adjust the size of the FIRST Logo using the Scale-X and Scale-Y and the 
position by the X-Distance and Y-Distance. When you’re satisfied click OK.



Let’s Build a Robot

41 – Create a Sketch on the surface of the Backplate.

42 – Using the Line Tool and 3-Point Arc Tool, trace the FIRST Logo.

43 – Finish Sketch, use the Press Pull Tool to Join it .25” out, and click OK.

44 – Delete the Canvas in the Timeline by right clicking on the icon and selecting 
Delete.



That’s it for now… next is Robot Motion and Synthesis


